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Abbreviations and Terminology

Following is a list of commonly-used abbreviations and terminology.

v
Administrative Console | ESSO-LM Administrative Console

Agent | Logon Manager

FTU | First Time Use Wizard

ESSO-Anywhere | Oracle Enterprise Single Sign-on Anywhere

ESSO-PG | Oracle Enterprise Single Sign-on Provisioning Gateway

ESSO-LM | Oracle Enterprise Single Sign-on Logon Manager

ESSO-PR | Oracle Enterprise Single Sign-on Password Reset

ESSO-UAM | Oracle Enterprise Single Sign-on Universal Authentication Manager
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About Oracle Enterprise Single Sign-on Anywhere

About Oracle Enterprise Single Sign-on Anywhere

Oracle Enterprise Single Sign-on Anywhere (ESSO-Anywhere) is the latest innovation in portable
single sign-on (SS0O) technology, enabling deployment of Oracle Enterprise Single Sign-on Logon
Manager (ESSO-LM) and, optionally, Oracle Enterprise Single Sign-on Provisioning Gateway
(ESSO-PG) to end users' desktops.

Using the ESSO-Anywhere Console, the administrator creates a deployment package configured
with the Oracle products needed by users of an enterprise, making the package available over a
Web server or file share. Users download this deployment package from an HTML interface that is
included with the ESSO-Anywhere package, and which the administrator customizes. Users can
then perform installations of the Oracle product suite on their own workstations at the click of a
button, with assurance that configurations are correct and ready to run, and without
administrator intervention.

:a ESSO-Anywhere is designed for compatibility with Windows Authenticator v1. It is not
“ designed to work with ESSO-LM features that require installing system services or
GINAs, adding registry entries outside of Live HKLM\Software\Passlogix, or additions to
Program Files or Windows system folders.

The Visual C++ Runtime Library and .NET 2.0 Framework are prerequisites for running ESSO-
Anywhere. The installation package includes the Visual C++ Runtime Library, however you must
make the .NET 2.0 Framework available to users. See the ESSO-Anywhere Release Notes for a
complete list of software and hardware requirements.

:a The final output of the deployment package is not an .MSI file. You must ensure that you
“ supply any additional requirements that your end users will need to run their ESSO-LM
and additional Agent software.

Due to security restrictions in Windows Vista, you must change group policy settings in
order for end users running Vista client to use the ESSO-Anywhere deployment
package. See the Technical Notes section in the ESSO-Anywhere Release Notes for more
information.
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Overview of Creating a Deployment Package

Following is the general procedure for creating a deployment package. Use the settings in the
three tabs of the ESSO-Anywhere Console for your deployment configurations. See the help topic
for each tab for an in-depth discussion of that tab's settings.

ESSO-Anywhere Deployment Limitations

Consider the following when planning your deployment options:

ESSO-Anywhere does not support Kiosk Manager. When you install ESSO-LM with the inten-
tion of using it to create a deployment, do not select the Kiosk Manager option.

You must be running a 32-bit operating system when creating a 32-bit deployment, and a 64-
bit operating system when creating a 64-bit deployment. Moreover, a 32-bit deployment
downloaded to a 64-bit operating system, or a 64-bit deployment downloaded to a 32-bit oper-
ating system, will fail.

ESSO-Anywhere does not recognize the v-GO Shared Accounts Manager Client. If it is present
in your ESSO-LM configuration, ESSO-Anywhere creates the deployment without it.

Creating a Deployment Package

1.

ua A W N

Create a certificate file to be submitted when you generate the deployment package. See the
document, Creating and Exporting an SSL Certificate for ESSO-Anywhere, on the Oracle Web
site, for complete instructions

Install the ESSO-LM Administrative Console and Agent on a clean workstation.
Optionally, install ESSO-PG.

Configure the Oracle products as you want them for deployment.

Make your ESSO-LM and ESSO-PG configuration settings available to ESSO-Anywhere:

e To use ESSO-Anywhere import configuration settings from the local registry (HKLM),
write the Global Agent Settings to the registry.

e To use ESSO-Anywhere import configuration settings stored in an ESSO-LM
Administrative Console .REG file:

a. Open the Microsoft Registry Editor (regedit.exe).

b. Save the registry file using regedit.exe.

:a.. Test your configuration before proceeding to create the deployment package.

Install the ESSO-Anywhere Console. ESSO-Anywhere reads the Oracle software configuration
on the workstation where you installed it.

. Verify in the General tab that the products and versions installed are the ones that you want

to deploy.
From the Options tab, specify:

e The deployment version and location, the installation location, and the installation type
e The update schedule preferences

e Which registry settings ESSO-Anywhere will use (the settings from the live registry, or
the registry file you saved using regedit.exe).
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Overview of Creating a Deployment Package

9.

10.
11.

12.

13.
14.

On the Generate tab:

a. Inthe Summary window, review all settings.

b. Enterthe directory path where the deployment package will be created, or click the
Browse... button to navigate to the directory.

c. Click the Generate button.

d. Atthe prompt, enter the location for the certificate file that you created, and the password.

The ESSO-Anywhere Console creates a deployment package in the location you specified in
the "Output folder" setting.
From the File menu, click Save or Save As... to save the deployment configuration settings.

Copy the deployment package to the virtual directory or file share that you specified in the "Tar-
get location" setting.

If deploying from a web server, customize the index.html file in the deployment directory,
replacing the generic text with the information that you want end users to see.

If this is a first installation, notify users that the deployment package is available.

To create additional deployment packages, reconfigure settings on the ESSO-LM Admin-
istrative Console, and click New on the ESSO-Anywhere File menu.

l- Tl Users do not have the option to alter the installation. If you want different users to install
“ different packages, create a separate deployment package for each installation.
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General Tab

The two sections of the "General" tab contain information about the Oracle products installed on
the workstation where you are creating the deployment package.

© Oracle Enterprise Single Sign-on Anywhere Console E]|E|®
File  Help
 General || Options | Generate
Installed products:
ESSO-LM 11.1.1.5.0
ESSO-PG 11.1.1.5.0
File version:

Mame Version Location ”~
Jjava policy 2M10/2011 2:25:06 PM  Helper'Java 3
ADAMSyncEd dil 7.0.0.286 Plugin®SyncMar ADAMext
ADAMSyricext vrs 7.0.0.286 Lang"Chs'\Fes
ADAMSynicext vrs 7.0.0.286 Lang'\Deu'Res
ADAMSyncext vrs 7.0.0.286 Lang“Eng*Res
ADAMSyncext vrs 7.0.0.286 Lang“Esp*“Res
ADAMSynicext vrs 7.0.0.286 Lang"Fra“Res
ADAMSynicext vrs 7.0.0.286 Lang"ta‘Res
ADAMSyncext vrs 7.0.0.286 Lang“JpnRes
ADAMSyncext vrs 7.0.0.286 Lang"KorRes
ADAMSyncext vrs 7.0.0.286 Lang"Pth"Res
ADsync dl 7.0.0.286 Plugin“.SyncMgriADext
ADsync vrs 7.0.0.286 Lang"Chs"Fes
ADsync.vrs 7.0.0.286 Lang'\Deu'Res
ADsynic.vrs 7.0.0.286 Lang“Eng"Res
ADsync vrs 7.0.0.286 Lang“Esp“Res
ADsync vrs 7.0.0.286 Lang"Fra“Res
ADsync vrs 7.0.0.286 Lang'ta“\Res het

Installed This section lists the Oracle products in the configuration. This list must contain
products ESSO-LM and might also include ESSO-PG.

File version | This section lists all components that were installed as part of the Oracle product
installation, with their version numbers and installation locations. This information
is the same as the information in the ESSO-LM "About" box.
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Options Tab

Options Tab

Use the "Options" tab to configure the settings for your deployment package.

Install

© Oracle Enterprise Single Sign-on Anywhere Console E]|§|@
File  Help

General |; .
Install
Deployment version:

Deployment type: Ingtall Locally A4
Tanget location:
(Example: hitp://server/vitual Directory or \\server\sharg)
Updates
[ theck befors the application starts
[] Check at a defined interval:

[ Specify a minimum reguired version:

Agent settings
(&) Live registry
() Exported registry file (REG):

Browse...

Use the settings in the "Install" group to configure the deployment version and file locations.

Deployment
version

Specify the four-field (x.x.x.x) version humber of the deployment. It is your choice
whether to match the deployment version to the version of ESSO-LM that you use for
the deployment.

Deployment
type

Specify whether ESSO-Anywhere will install on the local workstation.

The Install Locally option creates a shortcut icon to ESSO-Anywhere in the user's
Start menu and adds an entry for ESSO-Anywhere to the user's Add or Remove
Programs applet on the Control Panel.

The Online option is a per-session deployment and does not create the Start menu
shortcut or add an entry to Add or Remove Programs. It also requires the user to have
access to the web server or file share where the ESSO-Anywhere deployment
package is located in order to run ESSO-Anywhere. The files will be cached on the
user's machine, but the user cannot run the program directly.

Target
location

Enter the virtual directory or file share from which ESSO-Anywhere will be
distributed.
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Updates

Use the settings in the "Updates" group to specify when ESSO-Anywhere should check for
updates, and whether the user has the option to reject them when they are available.

:a If the user declines an optional update, ESSO-Anywhere does not offer that update

again.
Check Check this box to have ESSO-Anywhere check for updates to any of the installed files
before the | before the application launches. ESSO-Anywhere updates only files that have
application | changed.
starts
Check at Check this box to specify a time interval at which ESSO-Anywhere checks for updates.
defined Configurable intervals are from one hour to one year (52 weeks).
intervals
Specify a Check this box to enforce a minimum deployment version.
m|n|_mum This setting is useful for rollbacks. ESSO-Anywhere rolls back only one version. If you
required . .
. want to roll back beyond the previous deployment, rename the desired rollback to a
version . . . . ) - L
higher version than currently installed, and specify this new version as the minimum
required. Rollbacks are available through Control Panel > Add or Remove Programs >
Change > Restore.

Localized Deployments

In order for localized installers and update notifications to appear in the correct language, you

must have the

appropriate .NET language pack installed on the workstation. To install a .NET

language pack:

1. Logon to the local workstation.

2. Install the latest Microsoft .NET Framework if it is not already present (version 2.0 or above is

required).

3. Download and install the target .NET language pack for your version of the .NET Framework.
Restart the workstation.
5. Install ESSO-Anywhere.

The installer appears in the target language.

Agent Settings

Use the settings in the "Agent Settings" group to specify which registry settings ESSO-Anywhere

should use.
Live Select to use the same settings as in the ESSO-Anywhere live registry.
registry
Exported | Select to use a custom registry that you created in the Administrative Console and
registry exported. If you select this option, click the Browse... button to direct ESSO-Anywhere
file to the desired registry file.
(.REG)

— Page 10 of 11 —



Generate Tab

Generate Tab

Use the "Generate" tab to view a summary of your configuration settings, specify a location for
your deployment output, and generate your deployment package.

© Oracle Enterprise Single Sign-on Anywhere Console
File  Help

General || Options

Summary:

1. Installed products
ES50-LM 11.1.1.5.0
ES50-PG 11.1.1.5.0

2. Installer options

Deployment version: <Mot specified>
Deployment type: Install locally
Target location: <MNot specified=>
3. Updates
Check before application start: No
Check at defined interval: No
Minimum required wversion: <MNot applicable=

4. Agent settings

Output folder:

Generate

Browse...

Summary| Review the settings in the "General" and "Options" tabs.

Output Enter the path of the directory where you want to generate the ESSO-Anywhere
folder deployment, or click the Browse... button to navigate to the desired directory.
Generate | After you review your settings and specify the location of the deployment package, click

the Generate button to create the ESSO-Anywhere deployment package.

:Z: Before distributing the deployment package, verify that it works correctly.

The ESSO-Anywhere installation includes a customizable index.html file. Edit this file with the
information to direct end users to the deployment package, and distribute it.
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